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Introduction

In this module, the learner will explore the creation of web maps using Silverlight Viewer and
Viewer for Flex. The specific topics will include:

» Consume a service from the map server created in Topic 2 to create a web map:
— The Silverlight Viewer
— The Viewer for Flex
— HTML 5 (optional)
— Java (optional)

* The designer should compare and contrast the different map viewers, including looking at
strengths and weaknesses.

» Create a feature class web map service.

— Create a map that uses feature services, which will allow the user to add content
through a web browser.

— Describe the difference between a map service and a feature service.

Create Services
» Create at least three different services of the same geographic region. For example:

— State map with county boundaries
— Historical landmarks

— Demographic data

— Roads

— Rivers and creeks

» There are many shapefiles and geodatabases at the US Census Bureau that can be
downloaded and used to create the services.

» Utilize the same services in both the Silverlight and Viewer for Flex applications; these
services can be used with AGO in the next topic.

Display the service in ArcGIS Desktop
» Start with a blank map

» Load the services (at least three) j)

» Create a full screen image which shows both the table of contents and the map \ o \
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Creating a Silverlight Map

Provide the instructor with the URL to the created map. In addition, screen images are
required during the procedure that will assist the instructor in understanding how the
process was completed.

On the server, locate the Silverlight Viewer icon. When the icon is launched, it will take
the user to a website to download the viewer. Download the 64-bit version. Accept all
the defaults during the installation process. If the icon cannot be located, a simple web
search for the Silverlight VViewer from Esri can be done.

When the application is executed, a message may be received to install or update
Silverlight. If this prompt is received, it is a required process.

The version that this lesson is based on is 3.3.

The application will run in a web browser, it is suggested that Microsoft IE is used since
Silverlight is a Microsoft product.

Welcome

The ArcGLS Application Builder is a web application that allows you
te create and edit Viewer applications in a real-time and fully
interactive fashion. The Application Builder and Viewer applications
are built using the ArcGIS API for Silverlight.

To get started creating a Viewer, click the Create New Application
button below. The Viewer you are configuring will be shown below
the Application Builder's toolbar. You can configure your Viewer's
basemap, layers, tools, title, logo, colors, and more using the tools
on the toolbar. Once you have configured your Viewer, click the
Deploy button to deploy it to a new website.

Figure 1: Welcome Message

‘ h Create New Application

The first step is to open a blank map, then open a new map, see Figure 1 and Figure 2.

Topographic map which includes boundaries,
cities, water features, physiographic features,
parks, landmarks, transportation, and
buildings.

Featured Maps

Figure 2: Open Application

USA Topo Maps
Web Map by esri (last modified: January 8, 2015)
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o Note the tabs across the top of the window.

« When a different tab is selected the icons
below the tab change.

» A help getting started box related to each
tab is available, which can be disabled and
reopened as needed.

YTED 5§ TATES

» There are additional buttons on the upper
right that will be discussed later in this
lesson.

 Click on the button in the Add Content it
section, see Figure 3.

Figure 3: Add Content

Connecting to a Server

1. The IP address to one of the author’s servers has been
Browse entered with the appropriate location of the service

designated, see Figure 4.
216.69.2.43/arcgis

! ey 2. Place the name or IP address of the server that was
i “"”'ﬁ—,‘% created in Topic 2 and the pathway (normally
ArcGIS).

N

> i Colleges 3. Select a service.
> g Sam_Wright

> g US_Base

P g Wineries

» & Breweries2

» & Breweries

I @ Campuses

> @ Community Colleges
» 4 Gettysburg 1863
& Holiday Names Places

» & 1CTC 2012 ACS 2011

» & ICTC 2012 geography

Figure 4: Pathway to Services
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Adding a service
1. Add the selected layer to be displayed.
a) A service called Covered Bridge was selected.
b) Click on Add Selected Layer, see Figure 5 and
Figure 6.

2. This operation can be repeated to add additional services.
Use at least three services.

3. Services can come from multiple GIS Servers.

Results of adding a layer

LN I TED STATES

Figure 6: Initial Service Display

Repeat for additional layers

Three services were added but the river service has a dynamic
zoom level, thus the rivers are not displayed at this map scale, see
Figure 7. The zoom level was set before the service was created
in ArcMap. Note the basemap is a default at this time.
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Browsea
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Figure 5: Selecting a Service
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Right Clicking on a layer
* When a service is right clicked, a set a tools will be displayed. There are also tools at the
bottom of the screen.

Using Tools

= 1 ¢ Thefirsttool to be used is a configuration tool. Click on the tool to
USA_DBO_Covered_Brid.. gain control.
e ° Eachlayeris configured independently, see Figure 8.

£ Symbology

@ pop-ps * Note the Back button

B Table » The functionality of each tool should be explored.

bl » Some of the features might not be appropriate for the map.
» Configuring

~ Transparency

]
'
— Symbology - is similar to how it works in ArcMap, the symbols

set in ArcMap can be overridden.

| > Heat Map

| s Clustering

| y Auto-Updates |

— Pop-Ups — items that appear in the pop-up window can be
configured. The pop-up can either appear from a click or a hover

Eigure 8: Configuring a depending on the settings.
ayer

| > Feature Retrieval

— Table — allows the display of the an attribute table and can be
configured for what is visible to the user.

— Filter — is the query function, so not the entire data set is visible, this is a query
created by the designer not the user.

— Heat map — is used to create a heat map of the dataset.

— Clustering — gives a designer the ability to select the number of items and the distance
between them. When this is utilized a clustering circle will appear and will display
the number of events in the cluster. Sub-clusters map appear at different scale levels.

» Select the basemap layer
— There are nine default basemap layers (the same as seen in ArcMap).

— One of the nine basemaps must be selected, a default layer is used when the
application is started.

— OpenStreetMap was selected.

Select the Tools tab at the top of the screen, see Figure 9

» Note the several new items available to
configure, click on Add Tool.

» Select the Measure tool and then press Next, X F w H
See Flgure 10 AddTool  AddGP  Manage Configure

Figure 9: Tools Tab

Creating Web Maps
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Select a tool to add:

4 Analysis

ey !
,;.."S’, Measurel

4 Application

(% About
4 Attribute Table

4B Filter by Map Extent
4 Editing

¥ Editing

4 Geoprocessing

When a tool is selected a configuration screen will
open. The configuration screen allows the
designer to customize the tool. Click OK, once
the tool has been configured, see Figure 11.

Select multiple tools to configure and add to the
map.

The Editing tool only works if it is a feature class

% Geoprocessing ‘ Se rV I Ce .

4 Layer

¥ cConfigure Layer |« Some of the tools have multiple configuration
W= Filter Layer . WI ndOWS.

[ ol oy g

Figure 10: Measure Tool

easurements from existing features

* The tools will appear as small icons on the far
right side of the map.

» Make sure the project is periodically saved, this is
done by deploying the application, the first time
and saving after that.

e e | e The Add GP Function will not be directly covered

Figure 11: Tool Configuration

» Select the Manage under the Toolbar
heading, see Figure 12. In the Manage
Tools the order of icon, editing, removal
of tools and the adding tools can be
controlled.

Creating Web Maps

Manage Toolbars

Available Tools

4 |Anal |
;’f,,'; Measure
4 Application
%) About
4 Attribute Table
ﬂ*Fi\ter by Map Extent
4 Editing
_/. Editing
4 Geoprocessing
% Geoprocessing
4 Layer
4% Configure Layer

WeFilter Layer

Figure 12: Manage Tools

in this introduction to Silverlight maps.

Current Toolbars

4 Main Toolbar
B Choose Basemap
. Map Contents

. Attribute Table

& Clear Selection
.ﬁ, Measure

iFirter by Map Extent

| %ﬁquery Layer|

B service Details

4 Layer Toolbar

time G|
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» Click on the Layout tab, see Figure 13.

* Logo provides the ability to use institutional or

Organlzation Iogos Branding Layout Theme
. o . : @ = [ B
» Title and links gives the ability to personalize sy Tt clr?! Confeure  Reser
the map, instead of using the default.
* Layout provides multiple templates to the Figure 13: Select Layout Tab
designer.

» Configure allows the designer the ability to change colors so that they meet the
institutional or organizational colors, the templates have default colors.

* Reset has no parameters and if pressed gives no warning that everything is going to be
changed to the default layout.

» The final map is displayed in Figure 14.
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Figure 14: Final Map

To access this map goto: http://216.69.2.38/Apps/Mills%20and%20Covered%20Bridges/

Assignment: Create a Silverlight Map
» Use Silverlight to create a web map, of the designers choice. Make sure that
different commands are used to show the dynamics of this viewer.

» After creating the map, provide the instructor with the URL to it. In
addition, provide screen images along the process.

Page9
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Creating a Map in Viewer for Flex

One of the advantages of Viewer for Flex is that it works in a wide range of browsers,
Silverlight Viewer is sometimes limited.

Once a map has been created using Viewer for Flex, provide the instructor with the URL
to the map. In addition, provide screen images along the process, when the camera
symbol is present.

When the ArcGIS Viewer for Flex is chosen, the download page will appear. If the
download icon cannot be located, go online and search for the Viewer for Flex download
from Esri.

The version used in this module is 3.7. The downloaded file type is AIR, which will
require the AdobeAlRInstaller (free); the installer should be loaded before downloading
the Viewer for Flex file. There may be a need to create the Viewer for Flex folder
(flexviewer) under wwwroot and permissions to the folder should allow everyone to read
and write.

Once installed, run ArcGIS Viewer for Flex, and select a new application see Figure 15.

AecGIS Viewer for Flex - Application Buikder [=[o

P o applicaicn

_apsocm"nt‘_ [ Date Modified [ Actions
Begin building your first application

Figure 15: Starting Viewer for Flex

Name the application, use a descriptive name, [ Sr=atea NewApplication
i i Ication Hame I— * iy
Then click Create, see Figure 16. Application Name || )+ @

Application URL  http://216.69.2 38/Flexviewers/ @

The application which will be created is )
named historic_sites. WL cencn

Figure 16: Naming the Application

Creating Web Maps
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Select Basemap and Operational Layers

[&] ArcGIS Viewer for Flex - Application Builder

My Applications = historic_sites

T vooes || teyowt || Design || Prevew |
*4 Basemaps and

‘ Zi or
L W
& Operational

Web Maps
Layers

Figure 17: Initial Tabs

Basemap Tab
* The basemap can come from ArcGIS
Online, the learners server or the web thus
increasing the flexibility. Note Silverlight
only allowed the use of the nine
predefined maps. The example will use
Open Street Map from ArcGIS Online.

Layers

Notice the tabs across the top of the window
in Figure 18. Start with the map tab; see
Figure 17 tabs have been added to the side
and across the top of the selection.

-} AreGIS Viewer for Flex - Application Buider

B v ([ e | oo || e |

Basemaps & Operational Layers cyun: isuz: —

i [ Step 1 - Select Basemaps:
Sele

{2oerationalavers [is
[ 3Map Extent

No basemap layer currently selected.

[

7] Add Portal for ArcG15 Basemaps

Figure 18: Map Tab

The Operational Layers have options similar to their source as does the basemap, which includes
layers from ArcGIS Online. The layers used in this map will come from the ArcGIS Server,

Figure 109.

o ArcGIS Viewer for Flax - Application Builder

T e ([ oa | ower | P ]

* The Operational Layers tab has

Basemaps & Operational Layers oo ves s

E =

i [ Step 2 - Operational
,"““"'“.'.“ Provide the URL lo a data =g
EE

(tmor Y
!.Mlﬂ I
v

= — Selected Operaticnal layers

— Ho operational layer cumently selected.

been selected.

* The ArcGIS Server Tab is
selected next.

* Finally, the URL of the learner’s
server is entered.

¢ Once the URL is entered all of

= C4 T 2043 shudants (M5)

= 1 JCTC 2012 Transportabon (M)

» L) JCTC 2012 M5)

® 3 JCTCs) |
L4 JaTarson Coumte (MSL hd

the services available will be
displayed. Note a service with a
MS is a map service and those
with FS are feature services.

Figure 19: Operational Tab

Creating Web Maps

Many of the services have the
same name since both a map and
feature service was created at the
same time. The difference is that
the feature service can be edited.
However, a relational database is
required.
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» Three services will be added to the map.

» Each service can be added and then they can be arranged in the appropriate order.

* Each modification requires a save before leaving the screen or the changes will be lost.
There are no automatic saves done in this software.

» On the same window choose Map Extent
and it will bring up a basemap of the world.

°
Salem & o .. o &

» Center and zoom the map to show the data.
This is the initial view that users will see
when connecting to the created site.

* In Figure 20 the data is visible as well as the
basemap using OpenStreetMap.

Widget Tab
* In Figure 21, two widgets are pre-selected.

o Click on a widget and then click include.

— A configuration window will open
for the widget.

e | e [ oo [ e

— Widget i this appitcation
hy =
o

Draw

Figure 21: Widgets
— Each widget has a different configuration window.
* Add and configure widgets
— Explore the differences between a Legend and Layer List.

— Edit only works if the layer is a feature class.

Creating Web Maps
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— This area is left for the designers creativity.

Layout Tab

The layout tab allows the designer the ability to select the location of different mapping

components.
See Figure 22,
for the layout
window and
experiment with
different
options.

Viewer Header Placeholder

]

-1 H
LBl E
H
if
5
3
¥

Lot ngeser PIR 2y

o5
Rio.de
Pl feice
Preteris

wwwww

o | asibution

OueniewNan

fe

Figure 22: Layout Tab

Design Tab

o See Figure 23, The Design
Tab allows for the control of

fonts, Logo and Colors.

* The displayed colors scheme
was changed from the default.

o Atitle was also inserted.

Preview Tab
o See Figure 24, for the Preview

tab, which gives the designer
the ability to look at the map
before publishing it.

» Editing of all of the map features can be done after publishing, to refine the look.

Creating Web Maps
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Figure 24: Preview Tab

« This map is located at: Figure 25: Final Map

http://216.69.2.38/flexviewers/historic sites

* Figure 25 shows the Flex map in a web browser.

» Experiment with the different buttons on the map.

Assignment: Create a Viewer for Flex Map
» Use Viewer for Flex to create a web map

» After creating this map, provide the instructor with an URL to the map. In
addition provide screen images along the process.

» Use the same service as was used in Silverlight Map

Case Study: Create a Feature Web Map
» Silverlight or Viewer for Flex may be used.

» Create a map with a feature service, provide the instructor with the URL to the
map location. In addition provide screen images throughout the process that
will assist the instructor in understanding how the project was created. The
same service may be used as before however, the map service must be

Page 14
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modified to include a feature service. This will only work if all data in the service was
placed in a relational database when the project was started. Only one service should be
a feature service.

JCTC_CIT 229 Module 1 _Topic 3_Creating Web_Maps by Vincent A. DiNoto, Jr. is licensed under
a Creative Commons Attribution-NonCommercial-ShareAlike 4.0 International License.

This workforce product was funded by a grant awarded by the U.S. Department of Labor’s Employment and Training
Administration. The product was created by the grantee and does not necessarily reflect the official position of the U.S.
Department of Labor. The U.S. Department of Labor makes no guarantees, warranties, or assurances of any kind, express
or implied, with respect to such information, including any information on linked sites and including, but not limited to,
accuracy of the information or its completeness, timeliness, usefulness, adequacy, continued availability, or ownership.
This is an equal opportunity program. Assistive technologies are available upon request and include Voice/TTY (771 or
800-947-6644).
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